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1 What’s New 

This is an update 5 for the CodeWarrior for Microcontrollers V10.6.4. V10.6.4 already includes the 

updates 1 to 4, and you need V10.6.4 installed first to use this update. 

Freescale’s CodeWarrior for Microcontrollers v10.6.4 integrates the development tools for the 

ColdFire
®
, ColdFire+, DSC, Kinetis, Qorivva, RS08, S08 and S12Z architectures into a single product 

based on the Eclipse open development platform. Eclipse offers an excellent framework for building 

software development environments and is a standard framework used by many embedded software 

vendors.   

 

New device support:  

 Kinetis: WPR1516 

 S12Z: MC9S12ZVML31, MC9S12ZVM32, MC9S12ZVM16 

 

1.1 General 
1.1.1 Bug Fixes 

 No update 

1.2 ColdFire/ColdFire+ 
 

 No update 

 

1.3 Digital Signal Controller (DSC) 

1.3.1 Features 

 No Update 

1.3.2 Bug Fixes 

 ENGR354880 - [MCU v10.6/DSC] a problem when assigning a struct to a struct 

nested in a union. 

 ENGR00348264 – Wrong CRC calculation for DSC compiler 

1.4 Kinetis 
 

 No update 

1.5 Qorivva 
 

 No update 

1.6 RS08/S08 

 

 No update 

1.7 S12Z 

1.7.1 Features 
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• Added MAC support in the compiler (ENGR00353935) - MAC instructions are 

generated by using a peephole optimization on optimization levels starting with 

O2 

1.7.2 Bug Fixes 

• ENGR00360261 - small fix in object code generation (encoding) 

1.8 Component Development Environment (CDE) 
 

 No update 

 

2 System Requirements  

2.1 Recommended Configuration 

 2.6GHz Pentium® compatible processor or better  

 4GB RAM  

 20GB (When installing full product or updates for all architectures) 

 400MB on Windows system disk  

 DVD drive for installation  

 USB port for communications with target hardware 

 Ethernet port for communications with target hardware (optional) 

2.2 Operational Minimum Configuration 

 1.8GHz Pentium® compatible processor or better  

 2GB RAM  

 20GB (When installing full product or updates for all architectures) 

 400MB on Windows system disk  

 DVD drive for installation  

 USB port for communications with target hardware  

2.3 Host Operating System Support 

 Microsoft® Windows XP 32-bit and 64-bit (Professional Edition) 

 Microsoft Windows 7 32-bit and 64-bit (Home Premium Edition and Professional Edition) 

 Microsoft Windows 8 32-bit and 64-bit (Home Premium Edition and Professional Edition) 

 Microsoft Windows 8.1 32-bit and 64-bit (Home Premium Edition and Professional 

Edition) 

3 Product WEB page 

CodeWarrior Development Studio for Microcontrollers v10.6.4 is available for download at 

http://www.freescale.com/cwmcu10. 

4 Installation and Licensing 

This is an update to an existing CodeWarrior Development Studio for Microcontrollers v10.6.4, 

therefore you need to have that version already installed on your machine first to apply the update. 

http://www.freescale.com/cwmcu10
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To install CodeWarrior Development Studio for Microcontrollers v10.6.4, choose the download 

option that meets your needs. 

 

The online installer package contains the CW MCU v10.6.4 core tools and an installer, which 

assumes your computer has internet access. During the installation process the core tools will be 

installed and you will be asked to select the Freescale architecture support you want installed. The 

installer will automatically access the internet, download the necessary archives and install them in 

your CodeWarrior directory.  

 

The offline installer package contains the complete CW MCU v10.6.4 tool suite and an installer, 

which assumes your computer does NOT have internet access. All data needed by the installer will 

be downloaded and no other download will be performed. Double-click the installation package and 

a wizard will guide you through the installation process.   

 

 

An Evaluation license is automatically installed with your product and you do not need to register it. 

This license allows you to develop projects as Professional Edition during the evaluation period. 

After 30 days, the license works as a Special Edition license (free, permanent, but feature limited) 

which supports unlimited assembly code, up to 64KB of C code for S08/RS08, V1 

ColdFire/ColdFire+, Kinetis L Series derivatives; up to 128KB of C code for V2-V4 ColdFire and 

Kinetis K Series derivatives; and up to 512KB of C code for Qorivva derivatives. 

 

New functionality including support for new devices and other FSL architectures can be added to 

CodeWarrior Development Studio for Microcontrollers v10.6.4 (CW MCU v10.6.4) with archives, 

service packs, updates and patches. Archives add support for other FSL architectures. Service 

packs add specific support for new devices. Updates and patches correct software defects and add 

general functionality affecting more than one device family.  

 

New support can be added directly from the Internet or from a downloaded archive. If your computer 

is connected to the Internet, select Install New Software in the Help Menu and all available updates 

will be displayed. If your computer does not have Internet access, you can download the archive that 

contains the service pack, update or patch you need from CW MCU v10.6 Update & Patches and 

follow the Service Pack Updater procedure posted on the site.  

 

Note: Before installing archives, updates, service packs or patches, select Restart in the File menu 

to perform a CodeWarrior restart. This will ensure all processes (e.g. debugger shell) are closed. 

CodeWarrior should NOT be used during the installation process. 

 

Installing the v10.6.4 Update 5: 

The update is 500 MByte in size, and therefore recommended to download the update first as .zip 

file, and then install the update. 

1. Go to http://www.freescale.com/cwmcu10 

2. Click on the 'Downloads' tab 

3. Scroll down and select 'Download Options for the 'CodeWarrior Development Suite - 

Special': 

 

http://www.freescale.com/webapp/sps/site/overview.jsp?code=CW_UPDATES_MCU_10_6
http://www.freescale.com/cwmcu10
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4. Locate the MCU v10.6.4 Update 5 under 'Updates and Patches': 

 
5. Download the file. 

6. Start CodeWarrior for MCU10.6.4 

7. Use the menu Help > Install New Software 

8. Use the downloaded zip file as local update archive: Click the 'Add...' button, then use 

'Archive...' to point to the CW_MCU_v10_6_4_Update_5.zip file downloaded. 

 
9. Select the update(s) and go through the installation process with "Next >". 

 
10. Restart CodeWarrior at the end of the installation process. 

 

Alternatively, the following update site could be used: 

http://freescale.com/lgfiles/updates/Eclipse/MCU10_6_4/com.freescale.mcu.updatesite 

 

 

5 Technical Support  

All CodeWarrior issues are tracked through Freescale's normal Service Request Process. To report 

feature requests (enhancements) or defects for CodeWarrior Development Studio for 

Microcontrollers v10.6.4, please submit a Service Request.    

1. Go to http://www.freescale.com/support  

2. Log in.  

http://www.freescale.com/support
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3. On the resulting MyFreescale page, click Enter a Service Request  

4. Choose category Software Product Support  

5. Choose topic CodeWarrior  

6. Click Next.  

7. Provide the required information. You may attach a file up to 10 MB in size to the SR. You may 

also specify email addresses of people you would like to keep notified on the progress of the SR. 

Separate multiple email addresses with commas. Depending on the nature of the issue (defects 

require more information) you may need to provide some or all of the information listed below. 

 Type:  pick from Question, Defect Report, Feature Request 

 Subject:  be short and descriptive 

 Description:  details your question, defect or feature request 

 Severity:  choose from Medium, High, or Critical 

 Target:  specify the hardware microcontroller/microprocessor family involved 

 Reproducibility: choose from Always, Rarely, Sometimes, Unknown 

 Steps to Reproduce: be precise so we can reproduce the problem 

 Expected Result: what you expected to happen 

 Observed Result: what actually happened 

 Product: CW for Microcontrollers 

 Root Cause/Nature: enter root cause (e.g. software defect) 

 RTOS: enter the RTOS being used (e.g. NA)  

 Major: 10 

 Minor: 6 

 Patch: N/A 

 Component: enter component (e.g. Debugger) 

 Host: enter host operating system 

Please note:  

The Product field must be set to CW for Microcontrollers. This will allow the appropriate 

Freescale personnel to find SRs related to this project very easily, follow up as needed, report on 

them, and gather statistics on how the product is doing.  

8. When finished, click Submit.  

After Submit is selected, a confirmation page will be displayed with the SR number. You will also 

receive a confirming email sent to the address specified in your Freescale account. 
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Appendix A:  Known issues and Workarounds 

Issue ID Description 

General  

ENGR00265598 Description: When using "call by return" mechanism for calling functions in 
Performance View, a function will appear as if it has no children, and all its 
children will appear to be called from the function’s parent. 
Workaround:  None 

ENGR00285343 Description: Duplicate global variables are shown in the Variable View. 
Workaround: Use “Remove Global Variables” command to clean the Variable 
View and then add the required global variable(s) again. 

ENGR00300203 Description: Disassembly View is empty when a breakpoint is set in Outline 
View and the Disassembly View is no active when the breakpoint is hit. 
Workaround:  Use the "Link with Active Debug Context" button to refresh the 
Disassembly View. Uncheck it and then check it again. The Disassembly View 
will be refreshed. 

ENGR00299517 Description: The user component name in PEx project should be different than 
the name of the Eclipse project.. 
Workaround:  None. 

ENGR00337948 Description: Adding a New Component Category doesn't work [CDE]. It's not 
possible to add a user category for component. If the File->New->Other-
>Component Development Environment->Category wizard is used to create a 
category, the new category does not appear in the CDE and is not available for 
selection.. 
Workaround:  Step 1: Add the category to the file located in CodeWarrior 
directory: {CW10.6}\MCU\ProcessorExpert\Config\CDE\categories.xml. 
Step 2: Restart CodeWarrior.. 

ColdFire/ColdFire+  

ENGR00258435 Description: Target Task flash programmer fails to calculate the correct 
number of sectors to erase before programming a MCF54418 external NAND 
flash.  
Workaround:  Modify the Target Task to erase the correct number of sectors. 

ENGR00277322 Description: If the "reset" button is selected during a ColdFire debug session 
using a USB TAP (as opposed to "terminating" the debug session), 
CodeWarrior will hang. 
Workaround:  Terminate the DE.EXE program in the task manager.  

ENGR00328361  Description: After enabling Processor Expert in the existing project, new 
project wizard doesn't remove cfm.c file. It causes a compilation error. 
Workaround:  Remove Sources\cfm.c file in the project before or after enabling 
Processor Expert in the existing project.. 

DSC  

ENGR00282103 Description: CW MCU v10.4 DSC project using –largeAddrInSdm option will 
not build. 
Workaround: There is no support for -largeAddrInSdm option in project 
settings. The option can be specified on the “C/C++ Build->Settings->Tool 
Settings” panel of the “DSC Compiler/Language” page in the field “Other Flags”. 

ENGR00287718 Description: Processor Expert validation rejects valid configurations of DSC 
peripheral cross bar.  
Workaround: Use PESL macros instead of init components (Init_ENC and 
Init_AOI) or use ConnectPin method instead of high level and init components 
(QuadratureEncoder and Init_AOI). QuadratureEncoder must be configured for 
pin sharing.  



CodeWarrior Development Studio for Microcontrollers, v10.6.4Update 5 

 

 

Jul 21, 2015  8 

ENGR00299457 Description: Problem with breakpoints when debugging with USBTAP. 
Workaround: The issue occurs when a short watchdog period is specified. The 
watchdog should be disabled during debugging. 

ENGR00299753 Description: Unable to fill the DSC unused memory space with data 0x00. 
Workaround: None. INITVAL representing the link-time initialization value to 
be used for watermarking a memory segment in a linker command file does not 
work for zero input.  

ENGR00329421 Description: Processor Expert cannot detect name conflict between 
component name and PESL module name.. 
Workaround: Do not use following names for component:  ADC, ADC_SAR, 
AOI, CAN, CMP, COP, CRC, DAC, DECODER, DMA, EWM, FCAN, FCANMB, 
FLASH, FMC, FTFL, GPIO, HI8, HSCMP, I2C, INTC, LVI, MCM, MSCAN, 
MSCANMB, OCCS, PDB, periph, PESLlib, PGA, PIT, PMC, PWM, QSCI, 
QSPI, QTIMER, REF, RTC, SCI, SEMI, SIM, SPI, SSI, SYS, TOD, TSENSOR 
and XBAR. Please note that Processor Expert may also cause such conflict. 
See option 'Set periph. Init component name as peripheral'.. 

Kinetis  

ENGR00251403 Description: Timestamps greater than zero are reported in Trace Data View 
when Timestamps are disabled for ITM trace. The development platform is a 
Tracelink connected to a K21DN512 board. 
Workaround: None. When timestamps are disabled, the timestamps in the 
Trace Data View should be zero.  

ENGR00284177 Description: When an MQX project is edited to debug out of DDR on a TWR-
K70  board, the debugger does not download the code to the external DDR 
memory. 
Workaround:  None available. 

ENGR00291252 Description: Fail to get trace data when using Tracelink after reset. 
The trace data shows "Trigger packet - ETB" with no other data showing.   
Workaround:  Move trace viewer scroll bar up and down to refresh table 
content. 

ENGR00320744 Description: DMATransfer_LDD component with MQX does not put the 
#include "mqx.h" into the generated code and _mem_free in Deinit() is referring 
to an undefined variable.   
Workaround:  1) stop code generation of DMATransfer_LDD component  
2) add missing #include "mqx.h"  
3) In DMAT1_Deinit() method delete ((DMAT1_TDeviceData *)DeviceDataPtr)-
>DescriptorPtr = NULL;  
4) In DMAT1_Deinit() method replace _mem_free(DescriptorPtr) with 
_mem_free(((DMAT1_TDeviceData *)DeviceDataPtr)->DescriptorPtr); 

ENGR00349911 Description: User can get the same 'conflicting types for ...' error on the same 
components functions when build the "build_wsd" lib of twrk60d100m; then 
under the bsp_twrk60n512, add the "ExInt_LDD" compnent; enable "GerVal" 
method and build project.   
Workaround:  Add C preprocessor definition "bool=_Bool" in the GCC C 
Compiler settings - Define Symbols.. 

Qorivva  

ENGR00260637, 
ENGR00274574 

Description:  Software breakpoints do not work correctly on multi-core 
MPC56xx devices when a software breakpoint is set on one core while the 
other core is running. Due to software breakpoint corruption, the breakpoint on 
the running core is never activated. This only occurs when trying to debug two 
cores concurrently. 
Workaround:  Use hardware breakpoints, which work without limitations, when 
debugging two cores concurrently. Use software breakpoints when debugging a 
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single MPC56xx core. 

ENGR00284202 Description: The PXMMU configurator plugin is unavailable for MPC567xK. 
The MMU configurator view does not show the MMU entries and complains that 
the MCU is not in the devices list. 
Workaround:  None. 

ENGR00288114 Description: Debugger stops at a breakpoint on a line that has already 
executed. 
 
Use Case: This issue may occur on E200 devices when the debugger is halted 
manually by the user at an assembly line just in front of the software breakpoint. 
During software breakpoint handling the PC is changed by an offset of 2 which 
is especially problematic if a software breakpoint is set within a tight loop. 
Workaround:  Use hardware breakpoints which work without limitations. 

S12Z  

ENGR00296204 Description: Debugger Register View missing CPMUCOP (@0x0006cc) under 
Clock, Reset and Power Management Unit (CPMU).  
Workaround:  The register CPMUCOP is displayed under "Computer 
Operating Properly Watchdog (COP)" group. 

S08  

ENGR00286342 Description: The Target Task (Flash file to Target) does not program S19 files 
into MC13237. 
Workaround:  The default "Flash File to Target" task can be modified to 
remove restricted areas. The following actions are required: 

 Select "Save as Target Task" in the “Flash File to Target” dialog 

 Specify task name 

 Perform Erase and Program  

 In the dialog “Save Resource” specify the path 

 Open the Target Tasks tab 

 Select the saved task  

 Select “Edit task Configuration” from local menu 

 Double click on Erase and Program operations in the list of Flash 
Programmer actions  

 “Add Program/Verify Action” dialog will open  

 Uncheck "Restrict to Addresses in this Range"  

 Close dialog with “Update Program Action” button. 
Now use this task to flash the S19 files into MC13237. 
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Appendix B:  Freescale MQX™ RTOS Integration 

1 MQX 3.8 was developed to work with CW MCU v10.1. It is not supported in CW MCU v10.6. 

 

2 MQX v3.8.1 was developed to work with CW MCU v10.2. It is not supported in CW MCU v10.6. 

 

3 MQX 4.0 was developed to work with CW MCU v10.2 and CW MCU v10.3. It has been tested and 

confirmed to work with CW MCU v10.6. 

 
4 MQX 4.0.1 was developed to work with CW MCU v10.4. It has been tested and confirmed to work 

with CW MCU v10.6. 

 
5 MQX 4.0.2 was developed to work with CW MCU v10.4 and CW MCU v10.5. It has been tested and 

confirmed to work with CW MCU v10.6. 

 

6 MQX 4.1 was developed to work with CW MCU v10.5. It has been tested and confirmed to work with 

CW MCU v10.6. 

 

7 MQX Lite RTOS is integrated with CW MCU v10.6. It supports Kinetis E, K, L and V Series devices. 

To create a new project with MQX-Lite RTOS do the following: 

 

 Select New MQX-Lite Project in the Commander View. 

 Name the project. 

 Select a Kinetis device in the Devices dialog 

 Select a connection in the Connections dialog 

 Select preferred language and build tools options 

 A Processor Expert project will be created with the MQX-Lite component. 

 Configure the MQX-Lite component. 

 Add and configure other peripheral components to the project. 

 Select Generate Processor Expert Code icon in the Components View. 

 Add your application code to the project. 

  

8 MQX Task Aware Debugger is integrated with CW MCU v10.6.4 and is automatically installed. This 

plug-in can be used with all supported MQX versions (i.e. MQX 4.0.x, MQX 4.1 and MQX Lite).  
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Appendix C:  Performance Considerations 

CodeWarrior Development Studio for Microcontrollers v10.6.4 is a powerful tool chain. The following 

suggestions will help keep the CodeWarrior tools running at a respectable performance level. 

 

1 To maximize performance, the CodeWarrior tools should be installed on a computer with the 

recommended system configuration. While the tools will operate on a computer with the minimum 

configuration,  the limited hardware will restrict its ability to function at desired performance levels. 

2 Close unused projects. Eclipse caches files for all open projects in the workspace. If you need 

multiple projects open, try to limit the number of projects to no more than 10. 

3 The Eclipse IDE provides several options that provide user assistance tools. These options, however,  

use memory and cpu bandwidth. If performance is slow and you do not need these options, turn them 

off.  

 Scalability options configure how eclipse deals with large source files. 

o Scalability options 

 Editor live parsing: impacts parsing while typing, Outline View, semantic highlighting, 

folding, etc. 

 Semantic highlighting: C/C++ identifiers are colored 

 Syntax coloring: coloring of keywords, comments and literals 

 Parsing–based content assist proposals: content assist proposals which require parsing 

the file  

 Content assist auto activation: content assist activated automatically on trigger 

sequences, like '.', '::' or '–>'. 

o To disable: 

 Click menu ‘Windows’ –> ‘Preference’  

 Expand ‘C/C++’ –> ‘Editor’ –> ‘Scalability’ 

 Uncheck ‘enable scalability options’ 

 Content Assist Auto Activation can reduce the number of keystrokes a developer must type 

to create code. The Content Assist plug-in consists of components that predict what a 

developer will type, based on the current context, scope and prefix. 

o To disable: 

 Click menu ‘Windows’ –> ‘Preference’  

 Expand ‘C/C++’ –> ‘Editor’ –> ‘Content Assist’ 

 Uncheck all the options for ‘Auto Activation’  
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